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READ CAREFULLY BEFORE USING

Canon Software License Agreement

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE 
CD-ROM IN THIS BOX.  BY USING THE SOFTWARE, YOU AGREE TO BE BOUND 
BY THE TERMS OF THIS AGREEMENT.
This is a license agreement (the “Agreement”) between you and Canon Inc. 
(“Canon”).  
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, 
DO NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL 
SOUND AND IMAGE DATA) AND THE USER MANUAL IN THIS BOX 
(COLLECTIVELY, THE “SOFTWARE”) AND PROMPTLY RETURN THE SOFTWARE 
TO YOUR POINT OF PURCHASE FOR A REFUND.  
In consideration of the right to use the SOFTWARE, you agree to abide by the 
terms and conditions of this Agreement.

1. LICENSE
Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a 
single computer.  You may physically transfer the SOFTWARE from one computer to 
another provided that the SOFTWARE is used on only one computer at a time.  You 
shall not install or use the SOFTWARE on a network, multiple CPU, multiple site 
arrangement, or any other hardware configuration where the SOFTWARE is accessible 
to more than one CPU or to more than one user.
With respect to the sound and image data (“Data”) contained in the Software, which are 
to be downloaded to the applicable Canon digital camera product, Canon grants you a 
personal, non-exclusive license to use the Data on a single Canon digital camera 
product only.
YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR 
OTHERWISE USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER 
PROGRAMMING LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE 
THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN 
THIS AGREEMENT.

2. BACK-UP COPY
You may make one copy of the SOFTWARE solely for back-up purposes, or copy the 
SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and 
retain the original for back-up purposes.  Any other copying of the SOFTWARE is a 
violation of this Agreement.  You must reproduce and include the copyright notice on 
the back-up copy.

3. SUPPORT AND UPDATES
Neither Canon, nor its subsidiaries, dealers or distributors will be responsible for 
providing maintenance or support for use of the SOFTWARE.  No updates, fixes or 
support will be made available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY
It is your responsibility to choose, maintain and match the hardware and software 
components of your computer system.  Thus Canon does not guarantee uninterrupted 
service or correction of errors or that the functions or performance of the SOFTWARE 
will meet your requirements.  THE SOFTWARE IS LICENSED ON AN “AS IS” BASIS 
AND WITHOUT WARRANTY OR CONDITION OF ANY KIND. The CD-ROM storing the 
SOFTWARE is warranted only against defective material under normal use for a period 
of ninety (90) days after purchase from an authorized Canon dealer as evidenced by 
your sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of 
the same without charge when returned by you at your expense to your point of 
purchase and proven to be defective upon inspection.  The Replacement CD-ROM will 
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be warranted for the remainder of the original ninety (90) day warranty period of the 
defective CD-ROM.  The limited warranty does not apply if the failure of the CD-ROM 
resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend 
to anyone other than the original user of the SOFTWARE.
EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, 
CANON’S SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL 
WARRANTIES, OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING ANY 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.
NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR 
DEALERS IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING 
WITHOUT LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR 
DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVENIENCE 
HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE 
THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR 
DEALERS SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY 
CLAIM OR SUIT BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE 
OR THE USE THEREOF INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH 
THIRD PARTY.
SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES, OR THE LIMITATION OR EXCLUSION OF 
LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR PERSONAL 
INJURY OR DEATH RESULTING FROM NEGLIGENCE ON THE PART OF THE 
SELLER, SO THE ABOVE DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY TO 
YOU.

5. TERM
This Agreement is effective upon your using the SOFTWARE and remains in effect until 
expiration of all copyright interests in the SOFTWARE unless earlier terminated.  You 
may terminate this Agreement by destroying the SOFTWARE.  This Agreement will also 
terminate without notice to you if you fail to comply with any of the terms of this 
Agreement and you must then promptly return the SOFTWARE.  In addition, Canon 
may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE
The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 
1995), consisting of “commercial computer software” and “commercial computer 
software documentation,” as such terms are used in 48 C.F.R. 12.212 (Sept 1995).  
Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.72024 (June 
1995), all U.S. Government End Users shall acquire the SOFTWARE with only those 
rights set forth herein.  Manufacturer is Canon Inc./30-2, Shimomaruko 3-chome, Ohta-
ku, Tokyo 146-8501, Japan.

7. EXPORT RESTRICTIONS
You agree to comply with all export laws and restrictions and regulations of the country 
involved, and not to export or re-export, directly or indirectly, the SOFTWARE in 
violation of any such laws and restrictions and regulations, or without all necessary 
approvals.

8. SEVERABILITY
In the event that any provision of this Agreement is declared or found to be illegal by 
any court or tribunal of competent jurisdiction, such provision shall be null and void with 
respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 
Agreement shall remain in full force and effect.

9. CONTROLLING LAW
The terms of this Agreement as it relates to purchases of the Software in the United 
States of America shall be governed and construed in all respects in accordance with 
the laws and regulations of the State of New York, without reference to choice of law 
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principles.  The terms of this Agreement as it relates to purchases of the Software in 
Canada shall be governed by the laws of the province of Ontario.

10. OWNERSHIP
All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors.  Your 
use of the SOFTWARE is subject to the laws of the United States, and Canada, and 
other applicable copyright and trademark laws, and nothing in this Agreement 
constitutes a waiver of the rights of Canon, its affiliated corporations and third party 
licensors under such laws.  You only own the CD-ROM media in which the Software is 
stored.  Except as expressly provided herein, no license or right, express or implied, is 
hereby conveyed or granted by Canon to you for any intellectual property of Canon.  
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership 
rights in any images, graphics or textual material that you save in connection with the 
Software. 
You may not modify, remove or delete any or all copyright notices (i) which are 
contained in the Software, including any copy thereof, and (ii) which are on the original 
CD-ROM and on the medium of a back-up copy made pursuant to Section 2 above.

11. ACKNOWLEDGEMENT
BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ 
THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS.  YOU ALSO AGREE THAT THIS AGREEMENT IS 
THE COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN 
YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND 
SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR 
WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES 
RELATING TO THE SUBJECT MATTER HEREOF.  NO AMENDMENT TO THIS 
AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY 
AUTHORIZED OFFICER OF CANON.
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Read This First

Disclaimer

• While every effort has been made to ensure that the information contained in 
this guide is accurate and complete, no liability can be accepted for any 
errors or omissions. Canon reserves the right to change the specifications of 
the hardware and software described herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a 
retrieval system, or translated into any language in any form, by any means, 
without the prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost 
data due to mistaken operation or malfunction of the camcorder, the 
software, memory cards (MultiMediaCards or SD Memory Cards), personal 
computers, or peripheral devices, or due to use of a memory card not 
formatted by a Canon camcorder.

Trademark Acknowledgments

• QuickTime is a trademark of Apple Computer, Inc.
• Microsoft® and Windows® are either registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries.
• Other names and products not mentioned above may be registered 

trademarks or trademarks of their respective companies.

© Canon Inc. 2005 All rights reserved.

Safety Precautions
Do not play the supplied CD-ROM(s) in any CD player that does not support 
data CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player) 
could damage the speakers. It is also possible to suffer from hearing loss from 
listening with headphones to the loud sounds of a CD-ROM played on a music 
CD player.
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Checking Supplied Accessories

Use the following accessories to download recorded images from a memory card 
to your computer.

• IFC-300PCU USB Cable

• DIGITAL VIDEO SOLUTION DISK

The explanations in this manual use mainly Windows XP screen shots. The 
steps and windows may vary depending on your computer.
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System Requirements

Please install the software on a computer meeting the following minimum 
requirements.

Proper operation is not guaranteed on a dual CPU PC or on a user-built PC. 
Proper operation is not guaranteed on any particular system, even if it meets 
the requirements outlined above. 
A CD-ROM drive is required to install the software.

In this Instruction Manual, product names are abbreviates as follows:

OS: Windows 98 (Second Edition)
Windows Me
Windows 2000 (Service Pack 4)
Windows XP Home Edition or Professional
(Service Pack 1 or 2)
* Proper operation is not guaranteed on an OS that has 

been upgraded from a previous version. 

Computer Model: Computers that come with above OS preinstalled and 
have built-in USB ports.

CPU: Pentium 500 MHz or better

RAM: Windows 98/Windows Me: 128 MB or more
Windows 2000/Windows XP: 256 MB or more

Interface: USB: only preinstalled Windows 98/Windows Me/Windows 
2000/Windows XP systems with built-in USB ports 

Free Hard Disk Space: • Canon Utilities
- ZoomBrowser EX: 250 MB or more  (Including the 

PhotoRecord printing program)
- PhotoStitch: 40 MB or more

• Canon DV TWAIN Driver: 25 MB or more
• Canon DV WIA Driver: 25 MB or more

Display: 1024  768 pixels or better/High Color (16 bit) or better

Microsoft® Windows® 98 Second Edition: Windows 98

Microsoft® Windows® Millennium Edition: Windows Me

Microsoft® Windows® 2000 (Service Pack 4): Windows 2000

Microsoft® Windows® XP Home Edition or Professional
(Service Pack 1 or 2): Windows XP
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What is Digital Video Software

The following software will be installed by installing the Digital Video Software.

ZoomBrowser EX

• Downloading images from a memory card to your computer ( 17)
• Viewing downloaded images ( 28)
• Categorizing, organizing, and searching large volumes of images ( 34)
• Editing still images ( 33)
• Editing movies ( 41)
• Changing the data for still images and save them as new files ( 47)
• Viewing still images in a slide show ( 61)
• Adding sound to an image ( 69)

CameraWindow

• Selecting a method to download images in the Camera Control window 
( 19)

• Viewing images recorded on a memory card ( 23)
• Applying DPOF (Digital Print Order Format) settings ( 78)
• Uploading My Camera settings to the camcorder ( 70)

The Remote Capture function is not supported by your camcorder.
The slide show function of the camcorder cannot be used.

PhotoStitch

Merging a series of overlapping still images into a single, seamless panorama 
( 62)

PhotoRecord
• Printing still images with background, frame, title and comments ( 68)
• Printing indexes ( 66)
• Creating still image albums ( 65)

USB Driver
• Driver software that enables you to download images from a memory card to 

a computer. Users of Windows XP do not need to install this driver software. 
An OS standard driver will be installed automatically. ( 13)

• Windows 98/Windows 2000: Canon DV TWAIN Driver
• Windows ME: Canon DV WIA Driver

This instruction manual explains how to install the software, what you can do 
with the main features and how to operate them. For more detailed operational 
instructions, refer to the Help menu of each software program. 
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Installing the Digital Video Software

Be sure to install the Digital Video Software before connecting the 
camcorder to the computer.
Users of Windows 2000 or Windows XP must first log in as an Administrator 
to install programs. 

Windows XP Users:
Your digital video camcorder is equipped with the standard Picture Transfer 
Protocol (PTP). This protocol enables you to download images by simply 
connecting the camcorder to a computer with the USB cable (the software such 
as the [Scanner and Camera Wizard] starts automatically).
However, please note that there are several limitations to downloading images 
with this method. To avoid these problems, install ZoomBrowser EX to 
download images.

- It may take a few minutes, after connecting the camcorder, until you can 
download images.

- Images protected on the camcorder may lose this setting once they are 
downloaded to the computer.

1 Check a camcorder is not connected to the computer.
While a camcorder is connected to the computer, the software cannot be 
installed normally. If a camcorder is connected, detach the USB cable from the 
computer.

2 Close any programs that are running. 

3 Set the DIGITAL VIDEO SOLUTION DISK in the computer’s 
CD-ROM drive.

• The installer panel opens automatically. 
• If the installer panel does not open automatically, use the following procedures 

to display it. 
- Windows 98/Windows Me/Windows 2000:

1) Double-click the [My Computer] icon.
2) Right-click the CD-ROM icon and select [Open] from the displayed 

menu.
3) Double-click the [Setup.exe] icon. 

- Windows XP:
1) Select [My Computer] from the [start] menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed 

menu.
3) Double-click the [Setup.exe] icon.

Depending on the setting of your computer, the file extension “.exe” may not 
appear. 
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4 Select your language.

5 Click Digital Video Software [Install].

If the following dialog appears, click [Restart] to restart the computer. After 
restarting the computer, installation automatically continues.

Installer Panel
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6 Click [Next].

7 Select [Easy Installation] and click [Next].
To install the software individually, select [Custom Installation]. When you select 
[Custom Installation], select a USB driver. (Windows XP: The USB driver 
supplied with the Windows operating system is used. You do not need to install 
a USB driver.)
• Windows 98/Windows 2000: Canon DV TWAIN Driver
• Windows Me: Canon DV WIA Driver

8 Select your country/region and click [Next].

9 Read the license agreement and click [Yes].
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10Review the installation settings and click [Next].
• Installation starts.
• If the “Digital signature not found” message appears, click [Yes].

11When installation is complete, select [Yes, I want to restart 
my computer now.] and click [Finish]. 

12When the computer has restarted and the regular desktop 
screen is displayed, remove the DIGITAL VIDEO SOLUTION 
DISK from the CD-ROM drive.

When installation is complete, remove the DIGITAL VIDEO SOLUTION DISK 
before you connect the camcorder to the computer.

Windows 98/Windows Me/Windows 2000: At this point, the files for the TWAIN 
Driver or WIA Driver have only been copied to your computer. To download 
images via USB connection, finish installing the TWAIN Driver or the WIA 
Driver. For details, see step 4 in Connecting the Camcorder to a Computer
( 15).
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Connecting the Camcorder to a Computer

Make sure the camcorder is being powered using the power adapter before 
connecting it to a computer.
Be sure to install the Digital Video Software before you connect the 
camcorder to the computer.
Connect the USB cable directly to one of the computer’s main USB ports. 
The interface may not function correctly if the camcorder is connected via a 
USB hub.
The connection may not operate correctly if you are using other USB 
devices, excluding USB mice or keyboards, at the same time. If this occurs, 
disconnect the other devices from the computer and try reconnecting the 
camcorder.
Do not connect two or more camcorders to the computer. The camcorders 
may not operate normally.
Never allow the computer to go into standby (sleep) mode while a 
camcorder is connected via the USB interface. 

Refer to your computer manual for the location of the computer’s USB ports. 
See your camcorder instruction manual for connecting instructions.

1 Insert a memory card containing images into the camcorder.

2 Connect the power adapter to the camcorder. 

3 Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

Wait until the card access indicator stops flashing.

4 Attach the supplied USB cable to the computer’s USB port 
and the camcorder’s USB Terminal.

• The first time you connect the camcorder to the computer:
- Installation of the DV TWAIN Driver (Windows 98/Windows 2000) or the DV 

WIA Driver (Windows Me) starts.
- If the “Digital signature not found” message appears, click [Yes].
- After a few moments, a message such as “New Hardware Found” appears 

and the driver will be installed automatically.
- If you are prompted to restart the computer, restart the computer.

• Windows 98/Windows 2000/Windows XP: A window appears allowing you to 
select an application program to start.
Windows Me: The Scanners and Cameras Wizard starts. Click [Cancel] to 
close the Wizard.
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• For instructions on how to start ZoomBrowser EX and download images to the 
computer, see Downloading Images (ZoomBrowser EX) ( 17).

USB CableUSB Terminal 
on the Camcorder

 Camcorder End Computer End 

USB Port on 
the Computer
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Downloading Images (ZoomBrowser EX)

Observe following precautions when the camcorder’s card access indicator 
is flashing (the camcorder is reading or writing from or to the memory card). 
Failure to do so may cause memory card data to become corrupted.
- Do not open the memory card cover, remove the memory card or detach 

the USB cable.
- Do not turn off the camcorder or the computer.
- Do not change the position of the POWER switch or the TAPE/CARD 

switch.
Images recorded onto the memory card or downloaded to the hard disk are 
important original data files. Create a copy of the file first before working on it 
on your computer.
For Windows XP Users:
- Do not rotate the image in the [Windows Picture and Fax Viewer] or in the 

explorer view. The data for the original image will be changed and the 
image can no longer be displayed in ZoomBrowser EX or on the 
camcorder. 

- A movie file exceeding 210 MB cannot be downloaded.
- If the Server Busy window appears when you connect the camcorder to the 

computer, click [Retry].

You cannot connect the camcorder to a computer if the memory card 
contains more than 1800 images. For best performance, we recommend 
keeping the number of images on the memory card below 100 when 
downloading images to the computer. 

For instructions on how to connect a PC card reader/writer, see Using a PC 
Card Reader/Writer ( 27).
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Starting CameraWindow

1 Connect the camcorder to the computer ( 15).

2 Select [Canon CameraWindow Downloads Images From 
Canon Camera] and click [OK].

• The Camera Control window opens.
• If a camcorder and PC card reader are connected at the same time, a dialog 

appears allowing you to select the camcorder model. Confirm that [Canon 
Camera] or your camcorder model name is displayed and click [OK].

• Windows XP: If the window does not appear or if “PC CONNECT” does not 
appear on the camcorder screen, click the Windows [start] menu and select 
[All Programs], [Canon Utilities], [CameraWindow] and [CameraWindow].

- [Starts to download images]: The CameraWindow opens and images will be 
downloaded to the computer, and ZoomBrowser EX starts. For details, see 
Auto-Downloading ( 19). 

Camera Control window 
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- [Lets you select and download images]: The CameraWindow opens, 
displaying the camcorder images as thumbnails (small images). For details, 
see Downloading the Selected Images from the CameraWindow ( 23).

- [Preferences]: Setting the image type to be downloaded and the destination 
folder. For details, see Auto-Downloading Settings ( 20) or Setting the 
Direct Transfer Function ( 25).

• Placing a check mark next to [Displays this screen when the camera is 
connected] displays the Camera Control window automatically the next time 
you connect the camcorder via USB cable.

 (print/share) button may not be supported by your camcorder. For 
details, please refer to the instruction manual of your camcorder.
If the camcorder is already connected to the computer, you can start the 
CameraWindow and display the Camera Control window by clicking [Acquire 
& Camera Settings] followed by [Acquire Images] in the ZoomBrowser EX 
Main Window.
To start ZoomBrowser EX, click the Windows [start] menu, and select [All 

Programs], [Canon Utilities], [ZoomBrowser EX] and [ZoomBrowser EX], or 

double-click the  icon located on the desktop.

The Remote Capture function is not supported by your camcorder.

Using the Computer to Download Images

You can select a downloading method in the Camera Control window.

Auto-Downloading

1 Click [Starts to download images] in the Camera Control 
window.

• For instructions on how to set the Auto-download settings, see Auto-
Downloading Settings ( 20).

• Click [Finish] to close the Camera Control window.
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Auto-Downloading Settings
Select the setting for downloading images by operating your computer. You can 
change the image type and the destination folder.

1 In the Camera Control window, click the [Acquire Images] 
tab and click [Preferences].

2 Select [Change auto download settings] and click [Next].
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3 Select the image type to be downloaded and click [Next].
When the protect switch of the SD Memory Card is activated, those downloaded 
new images will not be marked as “already transferred” even having selected 
[New images] and downloaded.

4 Specify the destination folder settings and click [Next].

Click this button 
to specify the 
destination folder.  

Destination Folder

Select the 
configuration
of the subfolder.  
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5 Specify a process to perform after the image is downloaded.

Below window will be displayed when you select [Perform selected processes 
consecutively] (You can redisplay the window by clicking [Select]). Select a 
process to perform after the image is downloaded, and click [OK].
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6 Click [Finish].
Placing a check mark next to [Images are automatically downloaded to 
computer while camera is connected] downloads memory card images 
automatically to the computer when you connect the camcorder.

Downloading the Selected Images from the CameraWindow

1 Click [Lets you select and download images] in the Camera 
Control window.

The CameraWindow opens.
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2 In the CameraWindow, select the image you wish to 
download and click [Download pictures].

An orange frame appears around the selected image. 

3 Confirm the settings and click [Starts Download].
• ZoomBrowser EX starts, and the downloaded images appear in the Main 

Window. For detailed information about the Main Window, see ZoomBrowser 
EX Windows ( 28).

• Click [Finish] to close the Camera Control window.

Using the Camcorder to Download Images (Direct 
Transfer Function)

If your camcorder supports the Direct Transfer Function, you can use the 
camcorder to download images.
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When you followed steps 1 and 2 in Starting CameraWindow ( 18), the direct 
transfer menu appears on the camcorder screen and the  (print/share) 
button lights up each time you connect the camcorder to the computer.

If your camcorder is not equipped with the  button, operate the direct 
transfer menu using the SET dial. For details, please refer to the instruction 
manual of your camcorder.

1 Select a transfer option on the camcorder screen and press 
the button.

• See your camcorder instruction manual for how to set and operate the 
camcorder to transfer images.

• For instructions on how to change the destination folder and the folder name, 
see step 3 in Auto-Downloading Settings ( 20).

• The  button cannot be used when it is not lighted.
• You can set the action that is carried out for direct transfer. Right-click the 

[CameraWindow(Launcher)] icon on the taskbar and select an action from the 
displayed menu.

- [Show image(s) in fullscreen mode]: 
Displays downloaded images in 
full screen mode.

- [Launch ZoomBrowser EX]: 
Starts ZoomBrowser EX after 
downloading the images.

- [Show Window]: 
The Camera Control window 
appears when you connect the 
camcorder to the computer.

Setting the Direct Transfer Function

1 In the Camera Control window, click the [Acquire Images] 
tab and click [Preferences].
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2 Select [Change direct transfer download destination folder] 
and click [Next].

3 Specify the destination folder settings and click [Finish].
Click [Finish] to close the Camera Control window.

Click this button 
to specify the 
destination folder.  

Destination Folder

Select the 
configuration
of the subfolder.  
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Using a PC Card Reader/Writer

The basic operations of ZoomBrowser EX are the same as when you connect the 
camcorder to the computer. Follow the procedure below to open the 
CameraWindow. For instructions on how to connect the PC card reader/writer, 
please refer to its manual.

1 Insert a memory card containing images recorded with the    
camcorder into the reader.

2 Windows 98/Windows Me/Windows 2000: Click the Windows 
[Start] menu, and select [Programs], [Canon Utilities], 
[CameraWindow] and [CameraWindow].
Windows XP: When a window appears allowing you to select 
an application program to start, select [Download/View 
Images using Canon CameraWindow] and click [OK]. 

The Camera Control window opens.

3 Select a downloading method.
• [Starts to download images]: The progress bar will be displayed and images 

will be downloaded to the computer, and ZoomBrowser EX starts. For 
instructions on how to set the Auto-download settings, see Auto-Downloading 
Settings ( 20).

• [Lets you select and download images]: The CameraWindow opens, 
displaying the camcorder images as thumbnails (small images).
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ZoomBrowser EX Windows

This section explains the windows of ZoomBrowser EX. If you wish to start 

ZoomBrowser EX without connecting the camcorder or PC card reader/writer, 

double-click the  on the desktop, or click the Windows [start] menu and select 

[All Programs]  [Canon Utilities]  [ZoomBrowser EX] and [ZoomBrowser EX]. To 

exit ZoomBrowser EX, click  or select [Exit] from the [File] menu.

Main Window

ZoomBrowser EX’s Main Window features various buttons and an image display area.

1 Task Area
[Acquire & Camera Settings]: Use this to display the Camera Control window to 

download images and configure the camcorder 
settings.

[View & Classify]: Use this to view and organize images.

[Edit]: Use this to edit images.

[Export]: Use this to change the data for still images and 
save them as new files, back up to 
CD-R/RW, or export shooting properties to a text 
file.

[Print]: Use this to print selected images.

[Internet]: Use this to attach selected still images to E-mail 
messages.

1

2

3

4

6

5
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2 Folders Area
You can select a folder to be displayed in the Browser Area. Selecting the 
[Favorite Folders] tab shows only the folders that are registered as Favorites. 
To register folders as Favorites, follow the instructions below.

To remove the registered folder, select the folder, and click [Remove].

3 Browser Area

4 Browser Area Tool Bar

The menu items vary depending on the View Mode.

Clicking on 2 images while holding down the [Shift] key selects also all 
images between the 2 images.
Clicking on different images while holding down the [Ctrl] key selects multiple 
images.

When the [All Folders] tab is selected:
Select a folder and click [Add to Favorites].

When the [Favorite Folders] tab is selected:
Click [Add] and select a folder.

This area displays the images contained in the selected folder.

1 Previous/Next Displays the previous/next image in the current folder.

2 Up Displays the folder in the upper tiers of the hierarchy. 

3 Select Allows you to select all images and deselects images.

4 Information Allows you to select the information shown below the 
thumbnails.

5 Display Allows you to select displayed images according to the 
star rating.

1 2 3 4 5
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5 View Mode
You can select the view mode of images in the Browser Area.

[Zoom Mode]: The images in the selected folder are shown as thumbnails.

[Scroll Mode]: Thumbnails of the images are displayed next to the folder name. 
Clicking a folder displays enlarged images. Selecting [Preferences] from the 
[Tools] menu opens the [Properties] window, on which you can select the 
hierarchy of folders.

[Preview Mode]: A large image is displayed along with detailed information. You 
can change file name and comments. To display another image, click [Previous]/
[Next] or select an image shown at the bottom of the window.
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6 Application Tool Bar

1 View Image Displays a selected image in the [Image Viewer] window.

2 Properties Displays properties of the selected image. When you 
select a different image while the [Properties] window is 
open, the information switches to the one of the selected 
image.
The [Properties] window cannot be displayed in [Preview 
Mode].

3 Slide Show Displays still images in a slide show.

4 Search Allows you to search for images ( 37).

5 Delete Deletes selected images.

6 Rotate Rotates selected still images. A movie cannot be rotated.

1 2 3 4 5 6
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[Image Viewer] Window

The [Image Viewer] window appears when you select an image and click [View 
Image] or double-click an image.

1 Previous/Next Displays the previous/next image in the current folder.

2 Edit Allows you to perform red-eye correction, image 
correction, cropping, or to register external image editing 
applications. This button cannot be activated when 
multiple images are selected.

3 Show Allows you to display multiple images at the same time.

4 Synchronize Synchronizes the View functions across all displayed 
images.

5 Zoom In/Zoom Out Enlarges/decreases an image.

6 Pan When the image is larger than the window, you can move 
the image in the desired direction.

7 Fit to Window Matches the image size to the size of the Image Viewer 
Window.

8 Zoom Slider Allows you to enlarge/decrease the displayed image.

9 Show Image Full 
Screen

Displays an image in full screen size.

10 Change the Star 
Rating

Allows you to change the star rating.

7
8
9

10

1 2 3 4 5 6
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[Red Eye Correction] Window
Selecting [Red Eye Correction] from the [Edit] menu or the  icon allows 
you to correct the red eye effect on an image in the [Red Eye Correction] window.

[Image Correction] Window
Selecting [Image Correction] from the [Edit] menu or the  icon allows you 
to change the brightness, saturation, contrast, and RGB of the image.

[Crop] Window
Selecting [Crop] from the [Edit] menu or the  icon allows you to crop an 
image. Either drag the mouse on the image or specify the cropping area, and 
click [Crop Image].

1 Auto Mode Clicking [Start] corrects the red eye effect automatically.

2 Manual Mode Point the cursor on a red eye so that the area is 
highlighted green, and left-click the mouse.

1

2
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Organizing Images

Classifying the Images

This task allows you to classify selected images according to the shooting date.

1 Click [View & Classify] in the Main Window.

2 Click [Classify into Folder].

3 Select the images you wish to classify and click [Specify 
Classification Settings].
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4 Specify the settings and click [Finish].
The selected images are classified into the specified folder.

Renaming Multiple Files

This task allows you to rename multiple files at the same time, or to rename and 
copy multiple files.

1 Click [View & Classify] in the Main Window.

2 Click [Rename Multiple Files].
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3 Select the images you wish to rename and click [Specify 
Rename Settings].

4 Specify the settings and click [Finish].
The images are renamed according to the settings specified.

To rename a folder, select a folder, and open the [Rename Folder] window by 
selecting [Rename] from the [File] menu. Input the new name, and click [OK].
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Searching for Images

This task allows you to search for images by Star Rating, Modification Date, 
Shooting Date, Comment or Keywords.

1 Click [View & Classify] in the Main Window.

2 Select folders and images from which you wish to search 
and click [Search].
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3 Specify the search conditions and click [Start Search].
• The search results are displayed as thumbnails.
• Select at least one search condition.

4 Click [Finish].
• To change the search parameters and perform another search, click [Specify 

Search Condition] and repeat steps 3-4.
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• The images of the search result are displayed in the [Search Results] folder. 
You can print or copy these images to another folder. The images will remain 
in this folder until ZoomBrowser EX is closed or another search is performed.

Applying Star Ratings and Keywords

This task allows you to apply ratings to your images from one star to three stars. 
The Star Rating can be used as one of the search conditions, or for the selection 
of images to be displayed in the Browser Window. The keyword can be used as 
one of the search conditions.

The default setting of the Star Rating is two stars.

1 Select the image to which you wish to apply the Star Rating 
or Keyword.

2 Select [View/Modify Keywords] from the [Tools] menu.
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3 Place a check mark next to the keyword you wish to apply, 
or click on the stars for rating.

You can display images according to Star Rating by selecting [Filter by Star 
Rating] from the [View] menu.
You can add and delete keywords, or change the keyword list in the [Manage 
Keyword] window by selecting [Manage Keyword] from the [Tools] menu.
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Editing Movies

You can link images, insert text and background music, and add effects. You can 
also change the size of selected movies and save them as new files.

Editing Movies

QuickTime 5.0 or a later version is required to edit movies. If it is not already 
installed on your computer, install it from the DIGITAL VIDEO SOLUTION 
DISK. Place the disk in the CD-ROM drive and click QuickTime [Install] in the 
installer panel.

1 Click [Edit] in the Main Window.

2 Click [Edit Movie].
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3 Select images and click [Arrange].
You can select multiple images or a folder to include all images in that folder.

4 Arrange images and click [Apply Effect].
To change the order of images, select an image in the Storyboard Area and click 
[Move Left] or [Move Right].

Storyboard Area
Displays thumbnails of the 
selected images. The images will 
be linked from left to right.

Transition Box
Displays the symbol of the transition
effect between linked images.

Plays back the movies
being edited.
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5 Apply effects to the images and click [Set Audio].
• When you select [Apply effects to image], you can use the following functions.

- [Text Effect]: Opens the [Text Effect Settings] window. You can enter text, 
change the font and preview the effect.

- [Filter Effect]: Opens the [Filter Effect Settings] window. You can set the filter 
effect type, the start and end point, and preview the effect.

- [Magnify Section]: Allows you to view a part of the image in enlarged size.
- [Transition Effect]: Opens the [Transition Effect Settings] window. You can 

set the transition effect type and display time, and preview the effect. To set 
a transition effect, you need to select a transition box in the Storyboard Area.

6 Set the audio and click [Save].
• When you select [Set Audio], you can use the following functions.

- [Add Audio]: Opens the [Add Audio] window. You can add a MP3 or a WAV 
file as background music. 

- [Advanced Settings]: Opens the [Advanced Audio Settings] window. You can 
adjust the audio level of a movie or an audio file and apply audio faders. To 
set the advanced audio settings, you need to select a movie or an audio file 
which you added.
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7 Click [Save].
Movies are saved in DCF format files with Motion JPEG/AVI compression.

8 Click [Exit].

Destination Folder
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Playing Back Movies

In the CameraWindow and Main Window, movies are displayed with the first 
scene as a still image with a  (movie) icon. When you double-click the 
thumbnail in the Main Window, QuickTime Player starts and plays back the 
movie.

If QuickTime 5.0 or a later version is not already installed on your computer, 
install the QuickTime from the DIGITAL VIDEO SOLUTION DISK. Place the 
disk in the CD-ROM drive and click QuickTime [Install] in the installer panel.
Do not double-click a movie file (.AVI extension) in Windows Explorer.  That 
will start Windows Media Player, which may not support this file type. To play 
back movies, double-click the thumbnail with a movie icon in the Main 
Window’s Browser Area.

1 In the Main Window, double-click a thumbnail with a  
(movie) icon.

[Image Viewer] window appears.
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2 Click the  (play) button in the [Image Viewer] window.
The movie will be played back.
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Exporting Images

You can change the size, resolution or data for selected still images and save 
them as new files, or export still images for use as a screen saver or a wallpaper. 
You can also export selected movie and still image properties to a text file or 
copy and rename movies and still images.

Changing the File Type and Save

1 Click [Export] in the Main Window.

2 Select the export type.

When you have selected [Export Movies], see Exporting Movies ( 50).

3 Select images and click [Specify Export Settings].
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4 Specify the export settings and click [Finish].
The window varies depending on the selected export type in step2.

When you have selected [Export Still Images]:
You can convert still images to another file type, resize and save them as new 
files. You can select the file type from BMP, JPEG and TIFF. You can also specify 
a prefix to be added to the exported still images.

When you have selected [Export Shooting Properties]:
You can select the information you wish to export and save as a text file.
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When you have selected [Export as a Screen Saver]:
You can export and save the image as a screen saver.

When you have selected [Export as a Wallpaper]:
You can export and save the image as Windows wallpaper. This task cannot be 
performed if you have selected multiple images.
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Exporting Movies

You can change the size or data for selected movies and save them as new files.

QuickTime 5.0 or a later version is required to export movies. If it is not already 
installed on your computer, install it from the DIGITAL VIDEO SOLUTION 
DISK. Place the disk in the CD-ROM drive and click QuickTime [Install] in the 
installer panel.

1 Click [Export] in the Main Window.

2 Click [Export Movies].

3 Select a movie and click [Select the save format].
You can select multiple images or a folder to include all images in that folder.
Still images cannot be selected. For instructions on how to export still images, 
see Exporting Images ( 47).
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4 Select a file type and click [Set the save format].

5 Specify the export settings and click [Specify name of file to 
be saved].

6 Specify the file name and click [Start export].
In each case, specify the destination folder and file name of the movie to be 
exported.

Destination Folder
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7 Click [OK].
The Main Window appears.

Saving on CD-R/RW Disks (Windows XP Only)

You can copy and save images to CD-R and CD-RW disks. The shooting 
information is copied along with the images.

This function can only be used on a computer that came with a CD-R/RW drive 
as standard equipment.

1 Place a CD-R/RW disk in the computer’s CD-ROM drive.

2 If the following window appears, click [Cancel].

3 Click [Export] in the Main Window.
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4 Click [Backup to CD].

5 Select the folders or images you wish to save and click 
[Specify Backup Settings].

6 Set the backup settings and click [Start Backup].
The disk will be ejected from the drive when copying is complete.
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You can add images to a CD-R/RW disk that already contains images.

Saving Still Images from Your Computer to the Memory Card

You can save still images (JPEG) from the computer to a memory card of the 
camcorder and a PC card reader/writer. You can also save sample images for 
card mix from the DIGITAL VIDEO SOLUTION DISK.

Saving Still Images to the Memory Card

1 Connect the camcorder to the computer ( 15).

2 Click [Acquire & Camera Settings] in the Main Window.

3 Click [Set to Camera].
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4 Click [Uploads Images to the Camera].

5 Select the still images you wish to save and click [Open].
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6 Select the image size and click [Add].
The still images will be saved.

When you upload images edited with another application, images properties 
may be lost.

Saving Sample Images to the Memory Card

You can save sample images for card mix to the memory card of the camcorder 
and a PC card reader/writer. CARD CHROMA, CARD ANIMATION, CARD 
LUMINANCE and CAMERA CHROMA are provided on the DIGITAL VIDEO 
SOLUTION DISK.

1 Connect the camcorder to the computer ( 15).

2 Insert the DIGITAL VIDEO SOLUTION DISK to the 
computer’s CD-ROM drive.

If the installer panel opens, click [Exit] to close it.

3 Click [Acquire & Camera Settings].
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4 Click [Set to Camera].

5 Click [Uploads Images to the Camera].

6 In [Look in:], select the CD-ROM icon, and double-click [DVC 
CARD IMAGE].

Sample images or folders for CAMERA CHROMA, CARD ANIMATION, CARD 
CHROMA and CARD LUMINANCE appear.
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7 Select the sample images you wish to save and click [Open].

8 In the Add image window, click [Add].
The sample images are saved in the memory card.
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Using Various Functions

Attaching Still Images to E-mail Messages

You can attach selected still images to an E-mail message.

To use this function, the e-mail software must be enabled as MAPI client. For 
details, refer to the instruction manual of the e-mail software.

1 Click [Internet] in the Main Window.

2 Click [Email Images].

3 Select the still images you wish to send and click [Change 
Image Size].
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4 Select image size and quality, and click [Send or Save].
• If you wish to send the still image without changes, select [Send images 

unchanged]. Normally select [Resize and compress images into JPEG].
- [Resize Image]: Select the reduction ratio to the original still image.
- [Image quality]: The lower the quality, the coarser becomes the still image 

and smaller the file size. 
- Pressing [Apply] displays the file size after the compression as [Total size of 

changed images].
- You can check the compressed still image by pressing [View Images].

5 Select to send still images by e-mail or to save the still 
images in a folder and click [Finish].

• If you selected [Create a new email], your e-mail software starts and the 
selected still images appear as an attachment in the message window. Input 
address, subject and your comments and send the message. E-mail software 
not supporting MAPI does not start automatically. In this case, select [Save the 
images in a folder...].

• If you select [Save the images in a folder...], click [Browse] and select the 
destination folder. Start your e-mail software and attach the saved still image 
to a message.
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Running a Slide Show

You can view selected still images in a slide show. Movies cannot be selected for 
a slide show.

1 Click [View & Classify] in the Main Window.

2 Click [View as a Slide Show].

3 Select the images and click [Setup Slide Show].
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4 Select the slide show settings.
• [Image Size]: Select the size of the still images.
• [Image Information]: Select to show image information such as file name or 

title.
• [Advance to Next Slide]: Select to advance manually or automatically. When 

you select “Every 3 seconds”, you can select the interval in the control below 
(from 1 to 120 seconds).

• [Loop]: Select to stop the slide show after the last image or to continuously run 
it in a loop.

• [Effect]: Select the transition effect to be used when moving from one slide to 
another. When you click an effect, you can check the effect in the preview 
window. 

5 Click [Start Slide Show].
Click  in the lower right corner to end the slide show.

Merging Panoramic Images (PhotoStitch)

You can merge a series of overlapping still images into a single, seamless 
panorama. PhotoStitch automatically arranges still images recorded with the 
camcorder’s Stitch Assist mode in their correct order and orientation, making it 
easy to merge them. Please refer to the Camcorder Instruction Manual to learn 
how to record in Stitch Assist mode.
The following instruction explains how to merge still images recorded in Stitch 
Assist mode with the camcorder.

Still images recorded in Stitch Assist mode with Wide-converter or Tele-
converter attached cannot be merged correctly.
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1 Select images shot in Stitch Assist mode.
To use PhotoStitch, images need to be shot in Stitch Assist mode. To download 
images, please refer to Downloading Images (ZoomBrowser EX) ( 17).

2 Click [Edit].
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3 Click [Stitch Photos].
PhotoStitch starts.

4 Arrange the order of the images and click [2. Merge].
Operational instructions are displayed in the upper section of the window.

5 Click [Start].
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6 Select [3. Save] and then click [Save].
• Select the destination folder, input the file name and click [Save].
• In the View the Saved Image? window, click [Yes]. The Viewer window opens 

and displays the merged image.
• To exit PhotoStitch, from the [File] menu, select [Exit].

You can record the surroundings in 360 degrees, and stitch them together 
later to form a 360-degrees cylinder. (In [1. Selection and Arrangement], 
select [Arrange] and [360 degrees].) By saving this stitched image in 
QuickTime VR type, you can then get a virtual view of the surroundings by 
manipulating the mouse. For this, you need to have QuickTime installed on 
your computer.  If it is not already installed, install it from the DIGITAL VIDEO 
SOLUTION DISK. Place the disk in the CD-ROM drive and click QuickTime 
[Install] in the installer panel.
Please refer to the PhotoStitch Help menu for more details.

Printing Still Images (PhotoRecord)

PhotoRecord is a printing program. You can use this program to lay out the still 
images for printing. You can also create original albums and save them to your 
computer. Movies cannot be printed.

Do not open the memory card cover, remove the memory card, detach the 
USB cable or turn off the camcorder while data is being transferred to the 
printer (when the camcorder’s card access indicator is flashing). Doing so 
may cause memory card data to become corrupted.
If you are using a network printer and the printer name (including the 
network path) exceeds 31 characters, it may not be possible to print from 
PhotoRecord. If this happens, click the [Printers] icon from the Windows 
[Control Panel] and change the name of the printer, limiting its length to 
within 31 characters.
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1 Click [Print] in the Main Window.

2 Click [Layout Print].
When you wish to print an index, select [Contact Sheet Print].

3 Select the still image you wish to print and click [Select 
Captions for Printing].
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4 Select the image information you wish to include in the print 
and click [Open Layout Print].

• PhotoRecord starts.
• Place a check mark beside the items you wish include in the print.
• If you wish to add a comment, select a still image and enter a comment in the 

Properties window by clicking  (Properties). 

5 Click [Select Printer & Album Type] and select a printer and 
album type.

Select the album type.

Select the printer.
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6 Click [Select Paper] and select the media type, paper size 
and page orientation.

• If you click [Decorate Album], you can change the theme (a consistent design 
for background, photo frames and text frames), or set the design elements 
individually. When you set the design elements individually, make sure to 
select the target page.

• If you click [Add Titles & Captions], you can add titles and text, and change 
font, font size, justification and color. Make sure to select the target page when 
performing these changes.

7 Click [Print], confirm the number of copies and other print 
settings, and click [Print].

Printing starts.

PhotoRecord automatically performs image correction for images shot with Exif 
2.2 compatible camcorders and even other images, yielding high-quality prints. 

Set the paper type and orientation.
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Adding Sound to an Image

You can add a sound to an image. The sound file needs to be in WAVE format 
(extension “.wav”) or in MIDI format (extension “.mid” or “.midi”).
The sound cannot be played back on the camcorder.

1 In the Main Window, select an image and select [Add/
Remove Sound] from the [Edit] menu.

The Sound window appears.

2 Click [Add]. 
A window appears allowing you to select a file.

3 Select the sound file and click [Open].

4 Click [OK].
•  appears on the image.
• The sound file will be copied to the same folder as the image. 

To remove sound from an image, select [Remove] on the Sound window in 
step 2.  disappears and the copied sound file will be deleted.
To play back the sound, select an image with a sound icon and select [Play 
Sound] from the [Edit] menu. The [Play Sound] window appears and plays 
back the sound.
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Applying the Camcorder Settings from the Computer

Customizing the My Camera Settings

• The start-up image, start-up sound, shutter sound, operation sound and self-
timer sound are called the My Camera Settings. ZoomBrowser EX already 
contains several My Camera Settings which can be selected in theme sets or 
individually. The “Animal” theme, for example features and animal in the start-
up image and animal calls in each of the sound files. The files all begin with the 
same word (e.g. “Animal”, “Baseball”).

• You can use the pre-recorded My Camera Settings, add still images to the [My 
Camera] window ( 73) or create original sounds files ( 74).

• When you start the [My Camera] window form the Camera Control window, you 
can only change the My Camera Settings of the camcorder. To create an 
original sound file and add it to the [My Camera] window, start the [My Camera] 
window from ZoomBrowser EX. For details, see Creating an Original Sound File 
and Adding it to the [My Camera] Window ( 74).

Observe following precautions while the My Camera Settings are saved to the 
camcorder. 

-  Do not open the memory card cover or remove the memory card.
-  Do not detach the USB cable.
-  Do not turn off the camcorder or computer. 
-  Do not change the position of the POWER switch or TAPE/CARD switch.

Displaying the [My Camera] Window

1 Connect the camcorder to the computer ( 15).

2 Click [Acquire & Camera Settings] in the Main Window.

3 Click [Set to Camera].
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4 Click [Set My Camera].
The [My Camera] window appears.

Plays back the 
sound setting 
selected in the
 [Camera] list.

Displays the 
My Camera 
Settings of 
the camcorder.

Selects the type of the 
My Camera Setttings.

For individual 
settings.

For setting in 
theme sets.

Displays the 
My Camera 
Settings saved 
on the computer.

Adds an image 
file to the 
[My Computer] 
lists.

Plays back the 
sound setting 
selected in the 
[My Computer] list.

Deletes a setting 
from the 
[Camera] list.

Deletes a setting 
from the [My 
Computer] list.

Saves the setting 
from the computer 
to the camcorder.

Saves the setting 
of the camcorder 
to the computer.
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Changing the My Camera Settings of the Camcorder

1 In the [My Camera] window, select the theme set you wish to 
change in the [MyComputer] list.

• To change the settings individually, select the [Set individually] tab and select 
the setting type in the [Data Type] list.

• A start-up image appears when you select a theme set and plays back the 
start-up, shutter, operation and self-timer sound.

2 Select the setting you wish to replace in the [Camera] list 
and click [Save to Camera].



E

73Applying the Camcorder Settings from the Computer

W
in

d
o

w
s

3 On the confirmation window, click [OK].
• The selected setting is uploaded to the My Camera setting of the camcorder. 
• If you wish to use this setting on the camcorder, change the My Camera 

Setting on the camcorder itself. Refer to the Camcorder Instruction Manual for 
details.

Adding Still Images to the [My Camera] Window
By adding an image to the [My Computer] list, you can upload the image to the 
camcorder for use as Start-up Image. Only still images with JPEG compression 
can be added to the list.

To use still images recorded with your camcorder, you need to download them 
to the computer before you can add them to the [My Camera] window.

1 In the [My Camera] window, click the [Set individually] tab, 
select [Start-up Image] in the [Data Type] list and click [Add 
File].

The file opening window appears.
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2 Select the file you wish to add and click [Open].
The selected file appears in the [My Computer] list. You can now save the newly 
added file to the camcorder using the procedures described in Changing the My 
Camera Settings of the Camcorder ( 72).

To delete a setting, select the file and click the [Delete] button below the 
[MyComputer] list.

Creating an Original Sound File and Adding it to the [My 
Camera] Window

QuickTime is required to use My Camera Sound Maker and to play back the 
sound.

QuickTime is required to play back the sound. If QuickTime is not already 
installed on your computer, install the QuickTime from the DIGITAL VIDEO 
SOLUTION DISK. Place the disk in the CD-ROM drive and click QuickTime 
[Install] in the installer panel.
You need to connect a microphone to the computer.

1 In the Main Window, select [Manage My Camera] from the 
[Edit] menu.
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2 Click [Set individually] and [Create a My Camera Sound].
The My Camera Sound Maker window appears.

3 Click the tab of the sound type you wish to create and click 
[Record].

4 To begin recording, click the [Start] button.
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5 Click the [Stop] button to stop recording, and click [Close].
Recording stops automatically after 30 seconds. 

6 Edit the sound data so that it confirms to the time limits.
• Select the sound type by clicking the [Sound Format] button. 
• When a message appears in the center of the window, adjust the length of the 

recording to conform with the time limits by moving the blue and red switches 
and clicking the [Cut] button.

• The following chart shows standard time lengths for My Camera sounds.

Sound Type Lengths in Seconds

11.025 kHz 8.000 kHz

 Start-up Sound 1.0 sec. or less 1.3 sec. or less

 Shutter Sound 0.3 sec. or less 0.4 sec. or less

 Operation Sound 0.3 sec. or less 0.4 sec. or less

 Self-Timer Sound 2.0 sec. or less
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7 Click the [Save] tab, check if the sound file was created and 
click [Save].

8 Input a file name and click [OK].
• The created sound file appears in the [MyComputer] list.
• You can now save the newly created sound file to the camcorder using the 

procedures described in Changing the My Camera Settings of the Camcorder
( 72).

9 Click  to close the My Camera Sound Maker window.
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Applying DPOF Settings

You can select images and the number of prints for automatic printing on a DPOF 
(Digital Print Order Format)-compliant printer. You can set the DPOF print 
settings also on the camcorder.

When you are using a SD memory card, make sure the protect switch is set to 
allow recording.

1 Connect the camcorder to the computer ( 15).

2 Select [Canon CameraWindow Downloads Images From 
Canon Camera] and click [OK].
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3 Click the [Set to Camera] tab and click [Set Slide Show/
DPOF].

• When connecting a PC card reader/writer, click the [Set to Memory Card] tab 
and click [Set Slide Show/DPOF].

• The slide show function of the camcorder cannot be used. 

4 Click [Print Order(DPOF)] and select a print type from the 
drop-down list.

• [Standard Print]: Prints selected images in the specified number of copies. 
Use the arrows next to the boxes to select the number of copies.

• [Index Print], [Both (Standard/Index)] and the option [Titles] of the [Edit] menu 
(printing of date and file number) are not supported by the camcorder.
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5 Select the still images you wish to print and the number of 
copies.

6 Click [Save to Camera].
The DPOF print settings will be saved to the memory card.

The Edit Slide/DPOF window allows print settings on up to 998 still mages. 
With some camcorders, DPOF print settings are limited to a maximum of 200 
still images. In that case, all DPOF print settings on the 201st still image and 
onward will be erased.
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Reviewing and Changing the Settings of the Camcorder

You can adjust the date, time and owner settings of the camcorder. You can also 
check the remaining memory card capacity or format the memory card.

1 Connect the camcorder to the computer ( 15).

2 Select [Canon CameraWindow Downloads Images From 
Canon Camera] and click [OK].

3 Click the [Set to Camera] tab and click [Confirms/changes 
camera settings].
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4 Change the settings of the camcorder and click [OK].

Input a camcorder owner name 
here (up to 31 characters).

Set the date and time here.

Click this button to synchronize 
the camcorder to the computer's 
date and time settings.

Click this button to format the 
memory card in the camcorder.

Check the remaining memory 
card capacity here.

Check the power status here.
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Uninstalling the Software

Uninstall the software when you wish to delete it from your computer or when 
reinstallation is required to fix corrupted files.

Users of Windows 2000 and Windows XP must first log in as an Administrator 
to uninstall the driver and other programs. 

Uninstalling ZoomBrowser EX

1 Click the Windows [start] menu and select [All Programs] 
[Canon Utilities]  [ZoomBrowser EX] and [ZoomBrowser 
EX Uninstall].

The uninstall utility starts and removes ZoomBrowser EX. 

Uninstall all programs in [Canon Utilities] when you have uninstalled 
ZoomBrowser EX.
PhotoRecord and PhotoStitch can be removed with the same procedure.
RemoteCapture Task and RAW Image Task are used with Canon digital 
cameras. The camcorder does not support these programs.
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Uninstalling the TWAIN Driver/WIA Driver

Users of Windows XP do not need to uninstall the driver.

1 Connect the camcorder to the computer ( 15).

2 If a window for selecting an application program or the 
Scanners and Cameras Wizard appears, click [Cancel]. If 
ZoomBrowser EX started, close it.

3 Click the Windows [Start] menu and select [Settings] and 
[Control Panel].

4 Double-click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver/WIA 
Driver Uninstallation ( 86).

5 Windows 98/Windows 2000: 
1. Delete [Canon Camera] from the [Scanners and Cameras Properties] list.
2. Click [OK] to close the window.
3. Turn the camcorder POWER switch to OFF and remove the USB cable from 

the computer.
4. Click the Windows [Start] menu and select [Programs], [Canon Utilities], [DV 

TWAIN Driver x.x] and [TWAIN Driver Uninstall].
A version number appears in place of “x.x”.

Windows Me: 
1. Delete the camcorder icon from the [Scanners and Cameras] folder.
2. Click [OK] to close the window.
3. Click the Windows [Start] menu and select [Programs], [Canon Utilities], 

[DV WIA Driver x.x] and [WIA Driver Uninstall].
A version number appears in place of “x.x”.

6 When the Confirm Uninstall window appears, click [OK]. 
The uninstall process starts.

7 When the Maintenance Complete window appears, click 
[Finish].
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Troubleshooting

Connection

 Camcorder is not recognized when connected to the computer.
Computer does not support the USB interface.
The USB interface is not supported for computer not in compliance with the 
following requirements. Acquire the necessary system to use the USB 
interface.
Requirements: Built-in USB port on a system pre-installed with Windows 
98 (First or Second Edition), Windows Me, Windows 2000, or Windows XP.
There is no memory card in the camcorder.
Insert a memory card into the camcorder.
The camcorder is not set to the correct mode.
Turn the POWER switch to PLAY (VCR) and move the TAPE/CARD switch 
to CARD.
Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ( 15) and check the 
connection. 
Ensure that you are using the correct cable and that its connectors are in 
good shape.
If you are experiencing operational problems, detach the USB cable from 
the camcorder and computer and terminate the connection. Restart the 
computer and then reconnect the camcorder.
TWAIN Driver or WIA Driver is not installed properly.
First uninstall the TWAIN/WIA Driver, then reinstall the driver from the 
DIGITAL VIDEO SOLUTION DISK (remove the check marks from the other 
programs when prompted to select the programs to be installed).

ZoomBrowser EX Operation

 Cannot download images
The camcorder it not set to the correct mode.
Turn the POWER switch to PLAY (VCR) and move the TAPE/CARD switch 
to CARD.

Image files or folders do not appear in ZoomBrowser EX.
Images of folders shown in ZoomBrowser EX and the actual file contents 
may be different when an image file has been moved or copied using 
Windows functions or edited with a separate program.
Click the [View] menu and select [Refresh Current Folder].

Driver Installation

Cannot install the TWAIN Driver/WIA Driver correctly.
Does the system have a built-in USB port and did it come with Windows 
98 (First or Second Edition)/Windows Me/Windows 2000 preinstalled?
Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ( 15) and check the 
connection. 
Ensure that you are using the correct cable and that its connectors are in 
good shape.
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Are you using the power adapter to power the camcorder?
If the problem is not mentioned above, the TWAIN Driver/WIA Driver may 
not have been recognized by Windows. 
Uninstall and reinstall the driver.

TWAIN Driver/WIA Driver Uninstallation

If you had problems uninstalling the driver, use the following procedures to 
remove it.

The [Inf] folder contains numerous files that are critical to the computer’s 
operation. Be extremely careful not to delete the wrong files. If you delete the 
wrong file, you may be unable to restart Windows.

Use the procedures below for the following circumstances too.
- If you do not find [Scanners and Cameras] in the [Control Panel] or 

[Printers and Other Hardware].
- If [Canon Camera] or your camcorder model name does not appear in the 

[Scanners and Cameras Properties] or [Scanners and Cameras].
- If you connected the camcorder to the computer via the USB cable before 

installing the Digital Video Software.

Leave the camcorder connected to the computer.

1 Click the Windows [Start] menu and select [Settings] and 
[Control Panel].

2 Double-click the [System] icon.
The [System Properties] dialog appears.

3 Click the [Device Manager] tab.

4 If [Canon Camera] appears under the [Other Devices] and/or 
[Imaging Devices] categories, use the following procedures 
to delete it.

1. Select [Canon Camera] and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

5 Double-click the [My Computer] icon on the desktop 
followed by the [C:] drive and the [Windows] and [Inf] 
folders.
If the [Inf] Folder Is Not Visible in the [Windows] Folder

1. Windows 98: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.
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3. Windows 98: Set the [Hidden files] section to [Show all files].
Windows Me: Set the [Hidden files and folders] section to [Show hidden 
files and folders].

4. Click [OK].
This makes the [Inf] folder and files in the [Inf] folder visible.

6 Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

7 In the [Inf] folder, double-click [Other] folder to open it.

8 Find and delete the [CAP_xxx.inf] file.
• The xxx represents numerals.
• If the above file is not contained in the [Other] folder, you do not need to delete 

anything.

Leave the camcorder connected to the computer.

1 Click the Windows [Start] menu and select [Settings] and 
[Control Panel].

2 Double-click the [System] icon.

3 Click the [Hardware] tab.

4 Click the [Device Manager] button.

5 If [Canon Camera] or your camcorder model name appears 
under the [Other Devices] and/or [Imaging Devices] 
categories, use the following procedures to delete it.

1. Select [Canon Camera] or the name of the camcorder model, right-click 
the mouse button and select [Delete].

2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

Remove all copies of [Canon Camera] or your camcorder model name 
that appear in the [Other Devices] or [Imaging Devices] categories, or 
that appear more than once in one category.
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6 Double-click the [My Computer] icon on the desktop, 
followed by the [C:] drive, and the [Winnt] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder

Use the following procedures to show all files and folders.
1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Advanced setting] section, set the [Hidden files and folders] 

category to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check 
mark.

4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.

7 Look for the file for Canon digital camcorders starting with 
[Oem*].

• A number such as “0” or “1” will appear in place of the asterisk (*) above. You 
will also find another file called [Oem*.pnf], which will have the same number 
as the [Oem*.inf] file. The two constitute one set.

• There may be many file sets starting with “Oem”.
• If you double-click an [Oem*.inf] file, the Windows Notepad program will start 

and show the file contents. Click each [Oem*inf] file until you find one that 
contains “*** Canon Camera Driver Setup File***” in its first line. When you 
find the correct file, note down its name and close the Notepad window.

8 Delete the [Oem*] file set.
Delete all [Oem*.inf] and [Oem*.pnf] files, taking great care to delete the correct 
files.

If You Were Using ZoomBrowser EX Version 2 or 3 
(This manual explains version 5)

 Titles and comments added using a prior version than ZoomBrowser EX 
version 4 do not appear in ZoomBrowser EX 4 or higher.

Titles and comments added using a prior version of ZoomBrowser EX will 
not be displayed. Use the following procedure to display them.
1. In Windows Explorer, open the [Program] folder under the folder in which 

you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program).

2. Double-click [dbcobverter.exe].
3. Select the database you were using until now (C:\Program Files\Canon\

ZoomBrowser EX\Program) and click the [Start] button.
Please note that with ZoomBrowser EX 4 or higher, both titles and 
comments appear in the comment list.

 Cannot find the image folders saved with a prior version than 
ZoomBrowser EX 5.

Image folders saved under the [Program Files] folder (such as [Image 
Library One]) cannot be displayed in the Main Window’s Folder Area of 
ZoomBrowser EX 4 or higher. Use the following procedure to display 
them.
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1. In Windows Explorer, open the [Program Files] folder under the folder in 
which you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program\Image Library One).

2. Select the image folder you wish to display and copy the folder to a 
different destination.
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